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I really need to start off this month’s “Welcome”
column with an apology. Normally, I write
multiple articles for each issue of the magazine.
But for the February 2016 issue, I only had time
to write one other article, aside from this one,
my customary “Welcome” column. Things have
been B-U-S-Y.

To start off with, I have to take “call” at the
hospital where I work one day every two weeks.
I don’t know what’s blowing in the wind, but we
have been extremely busy. In fact, we’ve been
so busy that I’ve gotten called in extra to work
the last two times I’ve been on call. I have
another call shift coming up Monday, February
1, and I’m already anticipating that I’ll end up
getting called in to work for that call shift, due to
the increased workload.

Then, on this past Christmas morning, we (my
wife and me) found out we’re expecting our
second child! Here’s the really trippy part: both
children were conceived on the same day, we
found out that we were pregnant with both of

them on Christmas morning, my wife’s
temperature chart looks identical, and the due
date for both was/is August 25 … which is my
birthday. My son must have wanted his own
birthday, so he came early, on August 6.

Of course, winter days with REALLY nice
weather are definitely not the norm for us here
in the midwestern U.S. In fact, they are
predicting a significant snowfall and bitterly cold

temps within the next few days. So, we took my
son to the park after getting done getting the
sonogram at the OB-Gyn’s office.

So between working the extra shifts at the
hospital, doctor visits for the new pregnancy,
making sure my son gets the time he needs
and deserves from mom and dad, and
everything else going on with life in general … I
found myself without the time I usually had
available to write multiple articles. Hence, the
apology. I'm hopeful that things will get back to
"normal" for next month's magazine deadline.

Until next month, I bid you peace, happiness,
serenity and prosperity.

Welcome From The Chief Editor

Looking for an old article?
Can't find what you want? Try the

PCLinuxOS Magazine's
searchable index!

linuxfordummies.org

There Are No Stupid Questions

http://pclosmag.com/htdig
http://linuxfordummies.org/
http://www.linuxforums.org/forum/
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by Meemaw

It seems you can make practically any text design
you want, and this tutorial taught me a lot I didn’t
know! I add text to many of my projects, and I
always used the Text window to edit my text
(correcting a misspelled word, changing the font and
size, etc.), but I hadn’t really paid attention to the
toolbar that is directly above my work area. I found
out that you can use text window (the “T” at the top
of the window), but the toolbar just below it has more
options … many things can be done just using this
toolbar (at top).

Going from left to right, we start with the normal
settings: Font, Font Size, Font Style (Normal, Bold,
Italic or a combination) and Alignment buttons. We
even have two buttons for superscript and subscript,
if needed. From there, however, we have six settings
that can really make your text look different. Let’s
concentrate on this half of the toolbar (at bottom).

The first one is line spacing. This is useful if you
have more than one line of text. Inkscape’s default is
1.25. Depending on how you set it, you can put
letters right on top of each other (with a negative
setting) or space them far enough apart that
something can be put between them. One use for
this could be the award certificates that some
schools give to children. If you have a two-line
statement, you can space it out enough to leave
room for someone to write in the child’s name. If you
design your own certificates, this may work better for
your spacing than using the Enter key several times
in a row (center).

The second is letter spacing. This setting
determines how close or far apart your individual
letters are. A negative setting “smooshes” letters
closer together, and a positive setting stretches the
words out, as shown below. The center image is a
zero setting, or “normal”. This works well if you want
to make a banner fitting a precise length (top right).

The third of the settings is word spacing. You can
stretch your sentence out as much as you want by
increasing the space between each word. This might
help on your banner design, or a newsletter headline
or ad you want to emphasize (center, right).

The fourth one is kerning. This adjusts the letter
spacing only between the letters you've selected
(putting the cursor between the letters you want to
space out). As you see on the next page, I
separated the “e” from the rest of the word “Time”.

Inkscape Tutorial: More Text Tricks
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You can change the kerning on each letter
individually to get a different look. If you play with it a
bit and decide you don’t like it, you can use the
Undo function (<CTRL> + Z) which will undo them
one at a time, or choose Text > Remove Manual
Kerns to remove them all.

Shift is next. Shift moves letters up or down. Place
the cursor to the right of the letter you want to move,
then change the setting. A positive setting moves it
up and a negative setting moves it down.

Rotation is the last number setting in the toolbar.
You can rotate the letters one at a time by placing
your cursor to the left of the letter you want to rotate,
then changing the setting to a positive or negative
setting in degrees.

You can also highlight each letter and change the
color. I did the colors and rotated all of these. The
rotation setting is zero because no letters are
highlighted.

The last two buttons are text direction buttons.
Most of the time you will want your text to run
horizontally, but occasionally you might want vertical
text. Choose your text tool and type it in as usual. If
you forget, just highlight it and click the button and
your text will change.

Another way to edit your text is to use the path effect
editor. Change your text to a path (Path > Object to
Path), then click Path > Path Effects. Add the effect
you want (Bend, for example). In the Path Effects
window, choose the edit on canvas tool (the node
tool symbol) and you will get a line in your text to
manipulate, just like moving nodes. On this one, I
grabbed the center of the line and pulled it up.

Another path effect is the envelope, which we
covered in the December issue.

Have fun adding some more zip and pizzazz to your
text in your next Inkscape project.

Inkscape Tutorial: More Text Tricks

http://www.linuxforums.org/forum/
http://www.linuxfoundation.org/
http://pclosmag.com/html/Issues/201512/page01.html
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by Agent Smith (Alessandro Ebersol)

Another good, free to play MORPG, Arcane Legends
is a fantasy MMORPG based on browser in 3D by
SpaceTime Studios. Unlike traditional browser
MMORPGs, Arcane Legends is also available on
iOS and Android devices such as tablets and
phones, iPad's and Androids are supported. This
allows you to play in multiple platforms without the
need for a separate account, making it easier for
players to play anywhere, whether it be that bus
queue, waiting their turn on the bench…

Early in the game, players will choose one of three
classes including Warrior, Rogue, and Mage. As
players progress, each class will unlock various
skills that can be specialized in order to customize a
preferred style of play by the players. There is no
automatic attacks in Arcane Legends. The game
instead uses a system more action RPG oriented, in
which players must touch or hold the attack button in
order to perform a series of quick attacks or a single,
more powerful charged attack.

Players will also be able to choose a pet at the start
of the game. It follows the player around, and comes
with its own attributes and skills. Players do not
need to collect the drops from the monsters of the
game, as his pet will take care of it. The game
features over 40 unique animals allowed for players
to collect during their journey.

Features of the game

Graphics

The graphics are very good, made in a cartoon style.
They are the like Playstation 1 graphics, but well-

made and colorful. With good graphics, though
simple (the polygon count is not high), it guarantees
a good performance on all platforms, tablets, mobile
phones and even older computers/laptops.

Gameplay

There are tons of thugs to destroy through the
various game landscapes, with a brief list of
upgradeable skills to complement the attacks,
quests, leaderboards, a hodgepodge of pets to
collect and put to work by the player. There is also
an endless variety of drops to collect in various rarity
levels. The basics of hack'n'slash games is often lost
in translation from PC to phone, but Arcane Legends
captures the essence of the genre admirably, having
a consistent gameplay on all clients (PC, Mobile and
Tablet).

It is not a difficult game to learn, and it has simple,
straightforward gameplay. But, it's a lot of fun. It's
easy to enter the mainland of Arlor and pick up the
tricks of the game, improving your character from
there.

Opening Screen

The 3 Classes of the game

Playing Arcane Legends In PCLinuxOS
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Sound

The sound is very well done, with music composed
especially for the game, rather climatic, and with
good voice acting and sound effects.

Main points

• Large persistent world (semi-open), with many
different maps to explore.

• Hack and slash action and combat.

• Three different classes (Warrior, Rogue, Mage).

• Many pets to collect and train to fight by your side.

• Thousands of online players to interact in a
persistent world.

• Over a thousand different weapons, armor and
items to discover.

• Several mounts to travel everywhere in the maps.

Requirements: Have a Google Chrome browser
updated.

URL: http://www.arcane-legends.com/

Chrome Web Store:
https://chrome.google.com/webstore/detail/arcane-
legends/ibmlkgieigeddcedpbijnpojheoddido?hl=en

Playing Arcane Legends In PCLinuxOS

Full Monty ... Everything you might want or need –
plus the kitchen sink!

Are viruses,
adware, malware &
spyware slowing
you down?

Get your PC back
to good health
TODAY!

Get

Does your computer run slow?

Are you tired of all the "Blue Screens
of Death" computer crashes?

Download your copy today! FREE!

http://www.pclinuxos.com/?page_id=1413
http://www.linuxforum.com
http://www.linuxfoundation.org/
http://www.linuxforums.org/forum/
http://www.pclinuxos.com/?page_id=10
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International Community
PCLinuxOS Sites

Netherlands

Turkey

Denmark

Czechoslovakia

Italy

Poland

Brazil

Screenshot ShowcaseScreenshot Showcase

Posted by present_arms, January 1, 2016, running Trinity.

http://www.pclosusers.com/services-signup.php
http://www.pclinuxos.nl/
http://www.bekozap.com/
http://www.pclinuxos.dk/news.php
http://www.pclinuxos.cz/
http://pclinuxos.it/
http://pclinuxos.org.pl/
http://pclinuxos.fi/
http://www.pclinuxosbrasil.com.br/
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My Linux Valentine Sweet Linux Valentine

Downloading you oh how smart

Your system always free

Our love was meant to be

From you I never will part

Your source I like to tweak

Makes me feel just like a geek

Windows is an antique

You have my heart

Don't change a file for me

Keep your same style for me

For you I never have to pay

Each day is Linux Day

MP3 OGG

My Linux Valentine

http://pclosmag.com/html/Issues/201602/files/mylinuxvalentine.mp3
http://pclosmag.com/html/Issues/201602/files/mylinuxvalentine.ogg
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Ingredients

1 lb bulk Italian pork sausage
4 cups boiling water
1 cup milk
1/4 cup margarine or butter
2 boxes Betty Crocker™ au gratin potatoes
1/2 cup chopped green onions (8 medium)
2 tablespoons sliced green onions (2 medium)

Directions

1. Heat oven to 400°F. Spray 13x9-inch (3-quart)
glass baking dish with cooking spray. In 10-inch
skillet, cook sausage over medium-high heat, stirring
frequently, until no longer pink; drain.

2. In large bowl, mix water, milk and margarine. Stir
in 2 pouches Potatoes and 2 pouches Sauce Mix.
Stir in sausage and 1/2 cup green onions until well

blended. Pour potato
mixture into baking
dish.

3. Bake uncovered 35
minutes. Top with 2
tablespoons green
onions. Bake 5
minutes longer or until
potatoes are tender.
Let stand 5 minutes
before serving (sauce
will thicken as it
stands).

Options: Replace
Italian Pork Sausage
with hamburger, ham,
chicken or turkey.

It's easier than E=mc2

It's elemental
It's light years ahead

It's a wise choice
It's Radically Simple

It's ...

PCLinuxOS Recipe Corner

Sausage and Potatoes Italiano

http://www.pclinuxos.com
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A magazine just isn't a magazine
without articles to fill the pages.

If you have article ideas, or if you
would like to contribute articles to the

PCLinuxOS Magazine,
send an email to:

pclinuxos.mag@gmail.com

We are interested in general articles
about Linux, and (of course), articles

specific to PCLinuxOS.

Screenshot ShowcaseScreenshot Showcase

Posted by chilly, January 12, 2016, running KDE.

http://pclostalk.pclosusers.com
http://pclinuxos.com/?page_id=188
mailto:pclinuxos.mag@gmail.com
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by Paul Arnote (parnote)

Some portions of this article are from the SplashData press release.

SplashData has released their list of the most common passwords found on the
internet. This makes them the worst passwords to use, opening up your accounts
and personal data to being easily hacked by nefarious individuals.

Once again, “123456” and “password” top the list of the worst passwords. They
have maintained that ranking since SplashData started releasing their worst
passwords list in 2011.

SplashData compiled their report from over 2,000,000 (yes, two million) leaked
passwords during the year. With this being their fifth annual list, it’s quite amazing
at how much people put their data at risk with the use of poor, weak and
ineffective passwords.

Here is the 2015 Worst Passwords List Top 25:

Rank Password Change from 2014
1 123456 Unchanged
2 password Unchanged
3 12345678 Up 1
4 qwerty Up 1
5 12345 Down 2
6 123456789 Unchanged
7 football Up 3

8 1234 Down 1
9 1234567 Up 2
10 baseball Down 2
11 welcome New
12 1234567890 New
13 abc123 Up 1
14 111111 Up 1
15 1qaz2wsx New
16 dragon Down 7
17 master Up 2
18 monkey Down 6
19 letmein Down 6
20 login New
21 princess New
22 qwertyuiop New
23 solo New
24 passw0rd New
25 starwars New

For example, “1234567890”, “1qaz2wsx” (first two columns of main keys on a
standard keyboard), and “qwertyuiop” (top row of keys on a standard keyboard)
all appear in the top 25 list for the first time, but they are each based on simple
patterns that would be easily guessable by hackers.

As in past years’ lists, simple numerical passwords remain common, with six of
the top 10 passwords on the 2015 list comprised of numbers only.

Sports remain a popular password theme. While baseball may be America’s
pastime, “football” has overtaken it as a popular password. Both appear in the
Top 10 of SplashData’s list, with “football” climbing three spots to number seven
and “baseball” dropping two spots to number 10.

When it comes to movies and pop culture, The Force may be able to protect the
Jedi, but it won’t secure users who choose popular Star Wars terms such as
“starwars,” “solo,” and “princess” as their passwords. All three terms are new
entries on this year’s list.

Other passwords appearing on the 2015 list that did not appear on the 2014 list
include “welcome”, “login” and “passw0rd.”

If Your Password Is On This List, CHANGE IT NOW!
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SplashData, provider of password management applications including SplashID
for consumers and TeamsID for businesses (but not for Linux), releases its
annual list in an effort to encourage the adoption of stronger passwords to
improve Internet security. According to SplashData, the passwords evaluated for
the 2015 list were mostly held by users in North America and Western Europe.
The “Worst Passwords List” shows that many people continue to put themselves
at risk for hacking and identity theft by using weak, easily guessable passwords.

“We have seen an effort by many people to be more secure by adding characters
to passwords, but if these longer passwords are based on simple patterns they
will put you in just as much risk of having your identity stolen by hackers,” said
Morgan Slain, CEO of SplashData. “As we see on the list, using common sports
and pop culture terms is also a bad idea. We hope that with more publicity about
how risky it is to use weak passwords, more people will take steps to strengthen
their passwords and, most importantly, use different passwords for different
websites.”

PCLinuxOS users can use KeePassX as a capable password manager. It is
available in the PCLinuxOS repository, and can be installed on your computer via
Synaptic.

We have covered password security before in the pages of The PCLinuxOS
Magazine. If you want to review our previous articles, here is a list for your
convenience.

September 2013: Password Security Revisited
April 2007: What’s In A Password?
November 2013: KeePassX: Not In The Cloud
March 2010: Secure Passwords Made Easy
September 2009: Secure Passwords With openssl

To summarize best password practices, do the following:

1. Don’t use the same username and password on multiple websites.

2. Make your passwords 12 characters or more in length. Longer, complex
passwords are harder to hack and crack.

3. Avoid the use of personally identifiable information, like birthdays,
anniversaries, telephone numbers, names of wife/girlfriend, children and other
family members.

4. Avoid the use of popular hobbies, sports, sports teams, or movie
characters/stars, or anything else related to pop culture.

5. Use a mix of letters, numbers and punctuation marks. Vary the case of the
letters you use. An “A” and an “a” are not the same on the vast majority of
systems.

Also, it’s ok to “seed” your unique passwords with a common “root” password.
This way, you can easily make each site you visit have a very unique password.
For example, seeding all of your passwords with a unique passphrase (e.g.
iHearTd3BBi3), you can tailor each site by adding information unique to that site.
So, your password for Yahoo! Mail might become iHearTd3BBi3y!MaiL. Or, it
could be 16;iHearTd3BBi3yM. You decide how you want to construct your
passwords, and don’t divulge your methodology to ANYONE!

You owe it to yourself – and to the security of your data and personal information
– to protect that which is dear and vital to you, which is YOU!

Full Monty ...

Everything you might want or need –
plus the kitchen sink!

If Your Password Is On This List, CHANGE IT NOW!

http://www.pclinuxos.com/?page_id=1413
http://www.commandlinefu.com
http://www.splashdata.com/
http://pclosmag.com/html/Issues/201309/page08.html
http://pclosmag.com/html/Issues/200704/page04.html
http://pclosmag.com/html/Issues/201311/page09.html
http://pclosmag.com/html/Issues/201003/page07.html
http://pclosmag.com/html/Issues/200909/page03.html
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by Alessandro Ebersol (Agent Smith)

Well, now I will discuss about a very cool tip for Arc Welder, the native Android
emulator for Google Chrome, and hence, for our PCLinuxOS. As you can see
here, usually Arc Welder only allows you to install one APK at a time. The next
APK installed removes the previous APK.

But it is possible to install multiple APK's with Arc Welder.

How?

Easy, just follow these steps:

A) In the Google application menu, start Arc Welder.

B) Click on “Add Your APK.”

C) Choose the APK you want to install.

D) Do all the normal configuration process for the Android APK (orientation,
screen resolution, tablet or mobile phone.)

E) Now comes the important part that makes the difference: instead of clicking
Launch App, click Download Zip.

F) Now the zipped Android APK by Arc Welder should be in the folder
/Downloads (or any other that you have set for your downloads).

Step A Step B

Using Multiple Android APKs With ARC Welder

http://pclosmag.com/html/Issues/201509/page09.html
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G) Next, you must open Google Chrome settings, select Extensions, and enable
developer mode.

H) Then in your file browser (PCManFM, Caja, Dolphin, etc ...), open the zipped
APK package and extract its contents to a folder (can be Chrome_Apks or
whatever name you want).

I) In Chrome, Settings > Extensions, click “Load unpacked extension.”

J) In the "Open File" dialog that will follow, point to the folder where you
extracted the APK zipped package and it's done. It will add the APK Android as a
Google Chrome application from the applications menu, and you can repeat the
process as many times as you want, installing as many APK's as you want.

I hope you enjoy, and you should be able to use your favorite APK's on your
Android as much in your PCLinuxOS machines.

Until next month, when I will share some more tips on Arc Welder.

The PCLinuxOS Magazine
Special Editions!

Get Your Free Copies Today!

Using Multiple Android APKs With ARC Welder

http://pclosmag.com/special.html
http://www.dosgamesarchive.com/
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1. All the contents of The PCLinuxOS Magazine are only for general
information and/or use. Such contents do not constitute advice
and should not be relied upon in making (or refraining from
making) any decision. Any specific advice or replies to queries in
any part of the magazine is/are the person opinion of such
experts/consultants/persons and are not subscribed to by The
PCLinuxOS Magazine.

2. The information in The PCLinuxOS Magazine is provided on an
"AS IS" basis, and all warranties, expressed or implied of any
kind, regarding any matter pertaining to any information, advice
or replies are disclaimed and excluded.

3. The PCLinuxOS Magazine and its associates shall not be liable,
at any time, for damages (including, but not limited to, without
limitation, damages of any kind) arising in contract, rot or
otherwise, from the use of or inability to use the magazine, or any
of its contents, or from any action taken (or refrained from being
taken) as a result of using the magazine or any such contents or
for any failure of performance, error, omission, interruption,
deletion, defect, delay in operation or transmission, computer
virus, communications line failure, theft or destruction or
unauthorized access to, alteration of, or use of information
contained on the magazine.

4. No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation. All trademarks are the property of their respective
owners.

5. Certain links on the magazine lead to resources located on
servers maintained by third parties over whom The PCLinuxOS
Magazine has no control or connection, business or otherwise.
These sites are external to The PCLinuxOS Magazine and by
visiting these, you are doing so of your own accord and assume
all responsibility and liability for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The PCLinuxOS Magazine accepts no responsibility for the
content, accuracy, conformity to applicable laws of such material.

Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.

Disclaimer

Screenshot ShowcaseScreenshot Showcase

Posted by Gonzalo_VC, January 29, 2016, running MATE.

http://www.pclosusers.com/services-signup.php
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PCLOS is fantastic

As we use it more and more

We find that the experience

Never leaves us as before

Enjoy forum friendships

And those yet to come

Makes no difference how users look

Or where they might be from

We are so very much alike

Though we don't reveal a name

Never should we ever think

That our goals are not the same

PCLinuxOS Heart
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by Khadis

Inkscape has dozens of extensions that can help us
create various designs, illustrations, etc. In the
previous issues of this magazine, you have seen
many creations that used many techniques involving
different extensions. Now, I will show you some cool
extensions that you can use in your next designs.

Foldable box

Are you often curious about how to create a box
design for a product package? Using the Foldable
box extension, you can design a product package
template easily. Once you access it from
Extensions – Render – Foldable box menu, a
setting window will appear (left). There, you can set
the box size by setting up the box width, height, and
depth. Later, if you need to modify each part of this
package design, you only need to ungroup (Ctrl +
Shift + G) and the box will turn into editable pieces
(bottom, left).

QR code creator

QR codes are now everywhere, and QR code
creators are also can be found easily on the Internet.
But, do we really need a separate QR code creator
to put a certain “identity” in our products designed in
Inkscape? No. We only need an integrated QR code
creator right inside Inkscape, and it is already there,
under Extensions – Render – Barcode – QR Code
menu.

It is very easy and it takes no time to setup a ready-
to-use QR code. In the setting window, you only
need to put “something” in the Text field. In the
default setting, the Text field is filled by the Inkscape
homepage address. You can fill it with the
information you want. Then, in the Size field, you
can choose any size of QR code that matches your
needs. You can also choose the character encoding
you want.

L-system

Do you wonder about how to create instant dry
bushes for your illustration? Creating bushes from
lines and curves can take forever until it's done.
Don't worry, you can rely on L-system extension that
can be accessed from Extensions – Render menu.
With a single click, you will get a perfect bushes

Inkscape Tutorial:
Five Cool Inkscape Extensions You Must Try
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illustration. Since we need to understand how the
extension is working, for the complete help, we can
access the Help menu in the setting window of the
extension.

The similar extension that might help is Random tree
extension that can also be accessed from
Extensions – Render menu.

Cover template

Designing the cover of a book is much more easily
done in Scribus, although Inkscape can do the same
thing, depending on our creativity. If you want to
design a book cover using Inkscape rather than

another software, you can access Extensions –
Render – Layout – Perfect-Bound Cover
Template for a help. You only need to decide the
size of the cover (width and height), and start
designing it. The guidelines showing the margin
limits will be prepared by Inkscape.

Lorem ipsum

Lorem ipsum seems to be just useless text.
However, it is a very popular template of a
paragraph that we can find almost everywhere:
brochure templates, tabloid templates, etc.
Sometimes, when we are designing publication
material, we also need to show it to the client first.
And instead of using a final design with the whole
text, we can use lorem ipsum paragraph.

The good news is that lorem ipsum is available in
Inkscape and can be accessed from Extensions –
Text – Lorem ipsum.

Available in the following desktops:

KDE LXDE Xfce

Openbox Gnome

Enlightenment e17

Inkscape Tutorial: Five Cool Inkscape Extensions You Must Try

http://www.pclinuxos.com
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Want to keep up on the latest that's
going on with PCLinuxOS?

Follow PCLinuxOS on Twitter!

http://twitter.com/iluvpclinuxos

The place where breaking news,
BitTorrent and copyright collide

DOWNLOAD

Mate Desktop

Screenshot ShowcaseScreenshot Showcase

Posted by weirdwolf, January 10, 2016, running LXDE.

http://pclostalk.pclosusers.com
http://pclinuxoshelp.com/index.php/Main_Page
http://twitter.com/iluvpclinuxos
http://torrentfreak.com/
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by daiashi

About The Game

Knights of the Old Republic II is a role-playing video
game played from a third-person view that features
real-time combat. Combat and interactions with the
environment and non-player characters in Knights of
the Old Republic II is based on the d20 System as in
Star Wars: Knights of the Old Republic. The game
begins with the character creation menu that has
some race and gender selections available. After
your character has been chosen, you will be asked
to his or her character's abilities. There are 30 new
Force powers. The game has several mini games.
The interface has been streamlined from the original
game and party management was made easier; for
example, the player can now switch between two
selected weapon sets in the menu. As in the first
game, the player can choose to align with either the
light side or the dark side. As you progress through
the game, you will encounter many characters to
converse with. Your answer will determine your jedi
or sith path.

The combat of Knights of the Old Republic II is
identical to its predecessor. Several new lightsaber
crystals were added to the game. Each of them is

useful for a different situation. The player can use a
variety of melee and ranged weapons, including
swords and firearms. Fighting unarmed is also an
option. A new addition to the game are "prestige
classes". These are add-ons to the Jedi classes that
were established in Knights of the Old Republic.
They let the player character practice in lightsaber
combat or Force powers, depending on player
choice. Do not let the above phrase “Knights of the
Old Republic II is a role playing video game.”
discourage you.You have complete control over your
actions.When your character senses danger, the
game will pause and give you a course of action.
You can, of course, hit the spacebar to resume and
run around or from many opponents if tha’ts your
thing.

The player can travel with up to two fellow game
characters at a time, which gain experience points at
the same rate as the player character. Equipment
and perks for party characters can be selected for
different statistical effects or abilities. Players can
loot corpses and various environmental objects. The
protagonist also has the ability to "influence" their
game members by doing things that impress them,
the player increases their influence with them.
Depending on the level of influence, party members
may support the player character unconditionally or
turn on the protagonist. The player can also exploit
high influence by drawing party members to either
the light side or the dark side.

Previously I wrote on games that had a demo
version available. However, this is a purchase only
game. At $9.99, it is well worth it if you are a Star
Wars fan. I might add as well that the game is 10
years old and still is not going unnoticed. It received
a healty update as of 2015.

Hope you enjoy and “May the Force be with you.”

System requirements:

Fully updated PCLinuxOS and Steam

Hardware:

OS: PcLinuxOS

Processor: Intel Core i3 (2 Cores), AMD A10

CPU Speed: 2.2 GHz

Memory: 4GB RAM

Hard Disk Space: 10 GB

Video Card (ATI): Radeon HD 5450

Video Card (NVidia): GeForce 440

Video Card (Intel): HD 4400

Video Memory (VRam): 256MB

Controller Support: Steam Controller, Microsoft®
Xbox® 360 Controller for Windows® (Wired),
Microsoft® Xbox® 360 Games for Windows®
Wireless Controller with Adapter, SONY® PS3
DUALSHOCK®3 wireless controller (Wired),
SONY® PS4 DUALSHOCK®4 wireless controller
(Wired), Logitech Gamepad F310, Logitech
Wireless Gamepad F710.

About The Company

Obsidian Entertainment is an American video
game developer whose headquarters is located in
Irvine, California. It was founded in 2003 by ex-Black
Isle employees Feargus Urquhart, Chris Avellone,

Game Zone: STAR WARS
Knights of the Old Republic II - The Sith Lords
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Chris Parker, Darren Monahan, and Chris Jones
after the closure of Black Isle Studios.

Although they have created original intellectual
property, many of their games are sequels based on
licensed properties. Early projects include Star
Wars: Knights of the Old Republic II: The Sith Lords
and Neverwinter Nights 2, both sequels to games
developed by BioWare. The team then developed
their first original game, Alpha Protocol, in 2010. It
was met with generally mixed reviews. Other notable
works from Obsidian include Fallout: New Vegas,
Dungeon Siege III, and South Park: The Stick of
Truth, all also licensed properties.

Some Gameplay Screenshots

Getting It To Run

Install Steam (if you don’t have it installed already),
then start it. You will need to create a new account, if
you do not already have one. Once you have Steam
up and running, go to the store tab. Click on the
Linux tab if you wish and search for Kotor2. There is
no demo for this game. To purchase, it will cost you
only $9.99. If you have updated your system,
including graphics drivers, you should be good to go.

Kotor II

Donate To PCLinuxOS
Community Supported.

No Billionaires/Millionaires.
No Corporate Backing Or Funding.

Click here to make a one-time donation
through Google Checkout.

Or, click one of the amounts down below
to make a monthly, recurring donation.

Game Zone: STAR WARS Knights of the Old Republic II - The Sith Lords

http://www.pclinuxos.com/?page_id=7
https://gumroad.com/pclinuxos#LXoq
https://gumroad.com/pclinuxos#FGqC
https://gumroad.com/pclinuxos#zpNB
https://gumroad.com/pclinuxos#MPxaN
http://store.steampowered.com/app/208580/
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As told to YouCanToo

What is your name/username?
I am Gary Williams (AKA Buffalo Cowboy). This is in
remembrance of my long lost afro and love of all the
Black Cowboys and Buffalo Soldiers of the American
West.

How old are you?
I am sixty-one and looking forward to another click
on the meter in February.

Are you married, single?
Thirty-one years married and still going strong.

How about Kids, Grandkids?
Two grown and married sons. Five grandchildren.

Do you have pets, what is your favorite?
I'm a default dog dad for my youngest son's
Japanese Shibu Inu.

Are you retired, still working and if working, what
do you do?
I am a Desktop Support Technician in a MS
Windows environment for a Contracting Company. I
am a senior technician working with a lot of
Millennial and Gen X colleagues.

Where do you call home? What is it like? IE:
weather, scenery
Home is Northern Virginia about thirty miles from
Washington D.C. Living here is all about the

commute into and around D.C. (and how to outwit or
survive the legendary traffic snarls on a daily basis).

Weather in this part of the country will definitely give
you four distinct seasons. Lately, with the clearly
evident Global warming, the seasonal transitions
have been almost non existent or lingering unusually
long before abruptly switching to full out winter; or
like last spring, which was shortened before jumping
into full summer bake. The scenery here is still
spectacular once you go out into the counties away
from I-95.

Where did you go to school and what is your
education level?
I'm a Technical School Graduate with some College.
I am the last of a fading breed of technicians that
RTFM (I'm an old school Hacker before the media
misused and destroyed that term).

What kind of things you like doing? hobbies,
travel, fishing, camping?
I practice Martial Art Aerobics with a mixed group of
ladies, the majority of them young enough to be my
daughters and conditioned enough to be in the UFC.
I keep up with and routinely amaze them at every
practice. Every young guy who has come to the
class has not lasted more than two classes tops, so
far. When not doing weekday routines, I soak up as
much free Linux Knowledge as I can from all
available sources. Especially the user forum.

Why and when did you start using Linux?
I wanted to keep this Dell Inspiron 6000 alive when
Vista was launched back in 2009. I have never
looked back. This laptop runs KDE 4.14.10 and the
4.1.7 pclos3 kernel. I make my money supporting
MS in the daytime but use PCLinuxOS exclusively

for personal use and have even gotten my wife very
comfortable using it, too. So far, I've spread the OS
to two sister-in-law's' computers with positive results
all around.

PCLinuxOS Family Member Spotlight is an exclusive,
monthly column by youcantoo, featuring PCLinuxOS
forum members. This column will allow "the rest of us" to
get to know our forum family members better, and will
give those featured an opportunity to share their
PCLinuxOS story with the rest of the world.

If you would like to be featured in PCLinuxOS Family
Member Spotlight, please send a private message to
youcantoo, parnote or Meemaw in the PCLinuxOS forum
expressing your interest.

Defending Your Rights

In The Digital World

PCLinuxOS Family Member Spotlight:
Buffalo Cowboy

https://www.eff.org/
http://www.fsf.org
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Screenshot ShowcaseScreenshot Showcase

Available in the following desktops:

KDE LXDE Xfce

MATE Trinity

Enlightenment e17/e19

Posted by tbschommer, January 26, 2016, running Xfce.

http://chimpbox.us
http://www.pclinuxos.com
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Editor’s Note: Tip Top Tips is a new monthly column in
The PCLinuxOS Magazine. Each month, we will feature –
and possibly even expand upon – one tip from the
PCLinuxOS forum. The magazine will not accept
independent tip submissions specifically intended for
inclusion in the Tip Top Tips column. Rather, if you have a
tip, share it in the PCLinuxOS forum’s “Tips & Tricks”
section. Your tip just may be selected for publication in
The PCLinuxOS Magazine.

This month’s tip comes from PCLinuxOS forum
member Agent Smith.

I had to find another storage provider in the "cloud."
DropBox is becoming quite restrictive, so to speak.

I found Copy (http://www.copy.com/), a provider that
I found very good. 15 GB free, from the start, with
the possibility to increase with references.

Copy Agent has a native client for Linux. It’s
available for 32 or 64 bit OS architectures, is very
cool, easy to setup, and works very well.

But, since it has no installer, we have to follow this
simple recipe to add it to our PCLinuxOS system.

1. Signup for an account here.

2. Then, download the linux client:
https://copy.com/install/linux/Copy.tgz

3. Expand the tgz file. A folder, copy, is created.

4. As root, copy this folder into the folder /opt.

5. Create a .desktop file with your favorite plain text
editor. You can call it copy.desktop.

6. The contents of this file should be:

[Desktop Entry]
Encoding=UTF-8
Name=Copy Agent
Comment=Share Files
Exec=/opt/copy/x86/CopyAgent (note this line - If
your system is a 64 bit one, this line should be:
/opt/copy/x86_64/CopyAgent)
Icon=Copy-FB.png
Terminal=false
Type=Application
StartupNotify=true
Categories=GTK;Network;X-MandrivaLinux-
Internet-RemoteAccess;

7. Copy the icon from here to /usr/share/pixmaps
(you must do this as root).

8. Copy the .desktop file to /usr/share/applications
(which also must be done as root).

9. And voila, the Copy Agent icon will appear in your
start menu, in the Internet section.

I hope you enjoy the gigabytes of free storage from
Copy.com.

Are viruses,
adware, malware &
spyware slowing
you down?

Get your PC back
to good health
TODAY!

Get

Does your computer run slow?

Are you tired of all the "Blue Screens
of Death" computer crashes?

Download your copy today! FREE!

Tip Top Tips:
How To Install Copy Agent In PCLinuxOS

http://www.pclinuxos.com/?page_id=10
http://www.fsf.org
http://www.pclinuxos.com/forum/index.php/topic,122820.msg1026038.html#msg1026038
https://www.copy.com/page/home;cs_login:create_account;;section:landing
https://copy.com/install/linux/Copy.tgz
https://raw.githubusercontent.com/Redsandro/chocolatey/master/copy/img/copy.128x128.png


PCLinuxOS Magazine Page 26

If ever I would leave you it wouldn't be in summer
Booting you in summer I never would go
The heart of your system has brought world acclaim
Your graphical interface puts other flavors to shame

But if I'd ever leave you it couldn't be in autumn
Logging out in autumn would bring me great woe
Your beautiful desktop the ease of management
I never in autumn would leave accomplishment

And could I leave you in the winter all alone to undergo
Dancing the Samba with someone new oh no

If ever I would leave you how could it be in springtime
No command in springtime would ever make it so
Oh no not in springtime summer winter or fall
No never could I leave you at all

MP3 OGG

ms_meme's Nook:
If Ever I Would Leave PCLinuxOS

http://pclosmag.com/html/Issues/201602/files/neverwouldileaveyoupclos.mp3
http://pclosmag.com/html/Issues/201602/files/neverwouldileaveyoupclos.ogg
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Screenshot ShowcaseScreenshot Showcase

Support PCLinuxOS! Get Your Official

PCLinuxOS
Merchandise Today!

Posted by Vorteggs, January 4, 2016, running LXDE.

http://www.pclosusers.com/services-signup.php
http://www.cafepress.com/pclinuxos
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SCRAPPLER RULES:
1. Follow the rules of Scrabble®. You can
view them here. You have seven (7) letter
tiles with which to make as long of a word
as you possibly can. Words are based on
the English language. Non-English
language words are NOT allowed.
2. Red letters are scored double points.
Green letters are scored triple points.
3. Add up the score of all the letters that
you used. Unused letters are not scored.
For red or green letters, apply the
multiplier when tallying up your score.
Next, apply any additional scoring
multipliers, such as double or triple word
score.
4. An additional 50 points is added for
using all seven (7) of your tiles in a set to
make your word. You will not necessarily
be able to use all seven (7) of the letters in
your set to form a “legal” word.
5. In case you are having difficulty seeing
the point value on the letter tiles, here is a
list of how they are scored:

0 points: 2 blank tiles
1 point: E, A, I, O, N, R, T, L, S, U
2 points: D, G
3 points: B, C, M, P
4 points: F, H, V, W, Y
5 points: K
8 points: J, X
10 points: Q, Z

6. Optionally, a time limit of 60 minutes
should apply to the game, averaging to 12
minutes per letter tile set.
7. Have fun! It's only a game!

SUDOKU RULES: There is only one valid solution to each
Sudoku puzzle. The only way the puzzle can be considered
solved correctly is when all 81 boxes contain numbers and the
other Sudoku rules have been followed.

When you start a game of Sudoku, some blocks will be prefilled
for you. You cannot change these numbers in the course of the
game.

Each column must contain all of the numbers 1 through 9 and
no two numbers in the same column of a Sudoku puzzle can
be the same. Each row must contain all of the numbers 1
through 9 and no two numbers in the same row of a Sudoku
puzzle can be the same.

Each block must contain all of the numbers 1 through 9 and no
two numbers in the same block of a Sudoku puzzle can be the
same. D

o
w

n
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P

u
zz
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S

o
lu

ti
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n
s

H
er

e

Possible score 252, average score 176.

PCLinuxOS Puzzled Partitions

http://pclosmag.com/html/Issues/201602/files/2016-02-PuzzleSolutions.pdf
http://www.scrabblesite.com/scrabble/rules/
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1. Minimizes spots

2 . One section of extensions that allows

one to create specific node movements

3. Removes the color

4. Sharpens images

5. Blurs an object

6. The program's method of using the

instructions given it to reach the

desired result

7. Makes circular paths

8. Makes curly lines from selected

segments

9. Creates an abstract design

10. Creates a spherical shape

11. Makes a puzzle from your photo

12. Smooths out selected segments by

whatever percent you choose

13. Allows you to fill a space with sample

text

14. Makes a smooth line a bit rougher

15. Molds text to a 4-sided object

Download Puzzle Solutions Here

PCLinuxOS Puzzled Partitions

PCLinuxOS Crossword Puzzle: February 2016
Inkscape Extensions

http://pclosmag.com/html/Issues/201602/files/2016-02-PuzzleSolutions.pdf
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BARCODE

COLOR

COLORIZE

DESATURATE

DESPECKLE

EMBOSS

ENVELOPE

FRACTALIZE

GAUSSIAN BLUR

JESSY INK

JITTER NODES

LASERCUT JIGSAW

MODIFY PATH

OIL PAINT

PERSPECTIVE

RAISE

RASTER

RENDER

SHARPEN

SOLARIZE

SPIROGRAPH

STRAIGHTEN SEGMENTS

UNSHARP MASK

WHIRL

WIREFRAME SPHERE

Download Puzzle Solutions Here

I I I B U P T Y C U U G Q G L Q R D G N R X E N A C D Y R V

E J C C N I D P Z R S H A R P E N I Q K R L H M W Q E I T E

G E X Z S T A J E S S Y I N K Y L W F B Q W W B I G O Y P M

E K I L H M D W R S K I T A S B D E R E H W N Z Y Q X K X M

R T C C A E D V E E Y L S N P B H Z S J G A Y X M L Y L G U

J V W Q R O R X H X F N T Y I Q N I Y I F C U S O J H R K C

Y K G S P G K T P M Y H I T R A N R A T U S T T V B Q U A B

B A A A M Y B Z S Q T J E H O A P A R G T N N N Z E Q M R I

K L T E A H G J E Z J L V H G F N L O N R G R E S K Y J D P

P H D X S Y Q M M F K F C J R Q V O I F R M Y M Q K G C A N

J G V V K P X F A Z N G N F A X P S P O E Y Z G K V G K A U

J Y N Q B Y S R R Z K H W N P T L F C P T H L E T J N Y U A

F C X A U O T A F W T A S X H U B Q M Q S E A S I R V I Z X

P J O P G F R C E H E A V B B S D E K T A H J N T K T H H D

F K G A E M D T R X K B U R F F H E T Q R G D E T G A L I J

S W P A F C U A I K A T H J R W F O O A W U A T Y W H M V G

T K G G Z S I L W M U T A V B L O Q D W R N R H A X F B L L

A T W I F Z L I D S H S Q T G A A A A O O U T G Q B L W V P

D N E Z N O T Z D W G J U T R W R S P E B I T I M Y R N Q L

V J V V Q D Y E Z I R O L O C C G C U X W S X A F H O T N Q

S A L O D J R J W M C I K T E I S V O K R Y H R S T D E F U

M E M O D I F Y P A T H E B J U G R E D N E R T Y E Y M I P

V M H I R M L N N P S J I T T E R N O D E S B S S Q D J N T

I B X A A L V K N D V V U Q A A H N K E T R T P F J A L N W

T O I P R F K C M O J C N G K Q D W E P O L E V N E E J Y R

S S S I R T W E D O R I D Q T C K V V T Y C C N I W A W L U

E S H T U X X J C E V I T C E P S R E P K I C X W X E P T X

Y W M H A K D J S U G A U S S I A N B L U R F P P R O L O C

N T B B B X F A R K H S A B M M N K E B W R B H G A C I H T

I I P S M B L G P F A P E F M E F R P M P W J Q K J G R W V

PCLinuxOS Puzzled Partitions

Inkscape Extensions Word Find

http://pclosmag.com/html/Issues/201602/files/2016-02-PuzzleSolutions.pdf
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Posted by Crow, January 15, 2016, running KDE. Posted by HERTZ, January 14, 2016, running LXDE.

Posted by OnlyHuman, January 21, 2016, running e17.Posted by Ika, January 11, 2016, running Fluxbox.

More Screenshot Showcase




